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A9 Il Camera Configuration Overview

Customisation for
New Features

The A9 lll has a number of new features
such as Speed Boost, Pre-Capture and
Drive Mode Toggle that requires some
customisation of camera dials and buttons
in order to be a able to take advantage of

these features.

The basic dial and button customisation |
recommend is shown on the right. Further
explanation of the reasoning behind this

configuration is given in the following

pages.

Manual Exposure
M)

Dial Disabled (*)

ISO  Aperture

Shutter Speed

Dial Customisation

Pre-capture
on/off

AF On
(wide)

Zebras on/off

Subject Detect
Toggle

e Human

e Animal
e Bird
* |nsect
Shutter
Reg AF On
(Spot:XS)
Drive Mode
Toggle

e Single

e High+ (60fps)
e High (30fps)

e Medium ﬁSfps)
e Low (5fps)

Button Customisation

Start
Pre-capture*
(half press)

* if pre-capture
is on

Speed Boost
120fps on/of




WARNING: This camera is an action BEAST !
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WARNING: This camera is an action BEAST !
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Not surprisingly it is even capable of
capturing remarkable wildlife landscapes
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A9 Il Camera Configuration Overview

Dial Customisation

Manual Exposure

When shooting wildlife and in particular birds the brightness

of the scene can vary quite suddenly.

To further complicate things when shooting moving subjects
the background can change quite suddenly from, for example
a bright sky to a dark background of trees, bushes, rocks or

hills and mountains.

The subject may also move suddenly from being in the shade

to suddenly being in direct sunlight.

On overcast or partly cloudy days the sun may suddenly shine

through and light up the previously dark scene.

Even the best cameras automatic exposure systems are
unable to cope with such variation in the subject and

background lighting and for best results | recommend using

Manual Exposure
M)

Dial Disabled (*) IS0 Aperture

Shutter Speed

Dial Customisation

manual exposure.

Manual exposure means that you the photographer needs to
manually adjust the shutter speed, aperture and ISO
sensitivity depending on the subject and background lighting

conditions.

Fortunately the Sony A9 Ill provides three perfectly
positioned dials or wheels that can be assigned to each of the
exposure settings allowing instant adjustment with a finger
without needing to lift your eye off the view finder or hands

of the camera.



A9 Il Camera Configuration Overview

/ebras

In addition to providing dials for adjusting the individual
exposure settings Sony camera’s also provide a visual means
for determining when you have the perfect exposure on your

subject.

Zebras are diagonal zebra stripes that show up in the view
finders on parts of the subject that are either perfectly
exposed or over exposed, according to the Zebra levels you

have set in the camera.

Usually | set the Zebra mode to display stripes on parts of the

scene that are overexposed, i.e. Lower Limit 100+.

With this setting you would adjust your exposure so that the
brightest part of your subject is just no longer showing the

Zebra stripes.

The other option is to use the Std+Range setting using say 56
+ 3 giving a range of 53 - 59 so that parts of the scene with
mid level exposure between 53 and 59 show the zebra
stripes. This is useful when there is a very bright background
and you want to avoid being overwhelmed with zebra stripes

such that you can't see the subject in the scene.

Over Exposed
Area

Over Exposed
Area

Perfectly Exposed

Area

1S0, 4000

150,/800%

Reduce ISO
sensitivity

Reduce ISO
sensitivity
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Adjusting Exposure while
Shooting

Aperture - usually | will use the widest aperture available for
the lens | am using. So for the Sony 200-600 shooting at
600mm | will use 1/6.3.

Some lenses are not their sharpest when used with maximum
aperture and so you might want to set the aperture to the

widest setting that gives sharp images.

Shutter Speed - when shooting wildlife | typically will set the
shutter speed based on the amount of light and amount of

subject movement that might be expected.

The table below provides a rough guide of where to start.

Amount of Light Stationary

Slow Moving Active

Low - overcast and raining 1/40 1/250 1/640

Medium - bright overcast or 1/250 1/640 1/2000
hazy sunlight

Direct - early morning 1/640 1/1600 1/2600
levening direct sunlight

Harsh - late morning 1/2000 1/2000 1/4000
afternoon sunlight

Fast Action (e.g.
running, flying)

Note that very slow shutter speeds of 1/40s require camera/
lens stabilisation to be turned on when shooting handheld or

use of a tripod.

When shooting handheld | shoot a burst of images at 30fps
to try and ensure at least one or two images with no subject

or lens movement induced motion blur.

ISO Sensitivity - once | have decided on the appropriate
shutter speed | will adjust the ISO sensitivity until perfect

exposure is obtained on the subject as shown on the previous
page.

So exposure is primarily controlled during shooting using my

thumb on the rear dial configured with ISO Sensitivity.

Manual Exposure
M)

Dial Disabled (*) ISO Aperture

Shutter Speed

N/A

1/3200

1/4000

1/8000

Dial Customisation
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Button
Customisation

Shutter Button - the shutter button is configured to function
only as the shutter down button. It is not configured to also
set AF ON.

Focus Buttons - two back focus buttons are used instead and
are associated with two different focus modes, Wide Area

and extra small Spot.

Spot is used when picking out the subject requires a very
precise point, for example when there are multiple birds in
the frame or when a bird is partially obscured by bushes,

leaves or branches.

Wide focus area is used in conjunction with one of the subject
detection modes to allow the camera to automatically detect
the subject in the frame and focus on the eye of the subject.

| use this mode 99% of the time and in particular for birds in

flight where the subject may be anywhere in the frame.

Zebras on/off
Subject Detect

Toggle Start
e Human F’re—capture*
* Animal (half press)
e Bird o
* |nsect " i pre capture
Shutter
Pre-capture
on/off Reg AF On
(Spot:XS)
Drive Mode Speed Boost
AF O .
(wider)1 Toggle 120fps on/of
e Single
e High+ (60fps)
e High (30fps)
e Medium ﬁSfps)
e Low (5fps)

Button Customisation

This combination of shutter and focus buttons allows for the
focus to be locked in position and for shooting to continue
when using AF-C by simply no longer pressing either focus

button.

This is useful in some situations, such as low light conditions,
where the focus may hunt continually if in AF-C and if a focus

button if being pressed.
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Button
Customisation

Zebras on/off Button - usually | will leave zebras on but
occasionally with brightly lit backgrounds zebras can make it
hard to see the subject. This button can be used to

immediately toggle zebras on/off.

Subject Detect toggle Button - the individual subject type
detection modes generally provide the fastest and most
accurate performance so | prefer to use them. However this
means that if a different subject suddenly appears you will
want to quickly change the subject detection mode. This
toggle button will scroll through the configured modes for

quick selection of the required model.

Drive Mode toggle Button - during shooting you may want
to change the shooting frame rate. This button allows you to
instantly toggle through and select the desired frame rate

without needing to use the Drive Mode dial.

Zebras on/off
Subject Detect
Toggle Start
e Human Pre-capture*
e Animal (half press)
e Bird *if ore.
e |nsect igwogre capture
Shutter
Pre-capture
on/off Reg AF On
(Spot:XS)
Drive Mode Speed Boost
AF O P
(wide? Toggle 120fps on/of
¢ Single
e High+ (60fps)
e High (30fps)
e Medium ﬁSﬂos)
e Low (5fps)
Button Customisation

Pre-capture on/off Button - when situations arise where you
are expecting a sudden start to action that you want to
capture you might want to use pre-capture to ensure you
don’t miss the action. Using this button you can toggle it on

or off instantly.

Pre-capture can be initiated in different ways but my
preferred method is by half-pressing the shutter button.
Alternately this can be triggered by one of the focus buttons.
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Button
Customisation

Speed Boost on/off Button - the speed boost button
toggles speed boost on or off and is used in conjunction with

setting the Speed Boost speed to 120fps.

When combined with the drive mode toggle button you have
access to the full range of shooting frame rates without

needing to use any dials on the camera.

Depending on the type of subject typical use might be as

follows:

* Select the Drive mode to suit the type of subject. For large
slow subjects you may only want 15 fps, for large birds like
pelicans and egrets or eagles you may want 30fps and for

fast subjects like ducks or kestrels you may want 60fps.

e \When shooting faster subjects such as falcons, swallows or
small birds in flight or other sudden high speed action then
toggle Speed Boost on to get 120fps.

Pre-capture
on/off

AF On
(wide)

Zebras on/off

Subject Detect

Toggle
e Human
e Animal
e Bird
® |nsect
Shutter
Reg AF On
(Spot:XS)
Drive Mode
Toggle
¢ Single
e High+ (60fps)
e High (30fps)
e Medium ﬁSfps)
e Low (5fps)

Button Customisation

Start
Pre-capture*
(half press)

* if pre-capture
is on

Speed Boost
120fps on/of
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Shooting Menu Customisations

(A) (B) (C)

Shooting

(A) Still image shooting mode
(B) Movie recording mode
(C) Slow-motion/quick-motion shooting mode

Shooting 4/64
1 Image Quality/Rec JPEG/HEIF Switch
. Media Image Quality Settings
Key Settl ngs File Aspect Ratio
Shooting Mode 'BFile Format
Drive Mode 'BMovie Settings
Composite RAW Sht. % A%($ Shooting
JPEG/HEIF: HEIF Shutter/Silent Long Exposure NR
IMAGE FORMAT: RAW ONLY ’ WPage [@Close
RAW COMPRESSION: COMPRESSED Shooting > Image Quality/Rec 4/64
1 In JPEG/HEIF Switch HEIF(4:2:2)
Image Quality Settings
Set the cameras shooting mode dial to Aspect Ratio

'BFile Format
LR
O APS-( 35 Shooting

Photo mode (A) now.

v

WPage EB= ([@BClose




Shooting Menu - Image Quality JPEG/HEIF Switch

® ) JPEG
® H HEIF(4:2:0)

JPEG/HEIF o HEIF(4:2:2)

* JPEG is universally compatible

» HEIF offers better quality and compression but may not be

supported by all software and platforms. In particular HEIF

supports 10 bit colour while JPEG only supports 8 bit
colour. 10 bit colour means smooth gradients on areas Shooting > Image Quality/Rec

such as the evening or morning skies. 1 In JPEG/HEIF Switch
Image Quality Settings
Aspect Ratio
'BFile Format
'BMovie Settings

Fi |e Format O A5 % Shooting

* RAW only to reduce the required storage capacity

v

WPage = [EMClose

e |f you wish to download full resolution images to your
phone during shooting you may need to also record in Shooting > Image Qua... > Image Quality Settings
JPEG/HEIF if your phone does not support RAW files. SLOT 1

@ File Format RAW
RAW File Type RAW
HEIF Quality

HEIF Image Size

faRec. Media Settings




File Format

O RAW
® RAW & HEIF

Photo RAW File Type . SHEF

e Compressed - the number of images that can be stored in

Shooting Menu - Image Quality

the A9 Ill buffer is reduced if uncompressed or lossless
compressed is used. The buffer can hold around 190

compressed RAW files and around 100 uncompressed files.

* Use Lossless Compressed if possible when large buffer Shooting > Image Qua... > Image Quality Settings

capacity is not required, such as when shooting still images SLOT 1
@ File Format RAW

RAW File Type RAW
HEIF Quality
HEIF Image Size

or when using low frame rates.

PaRec. Media Settings

RAW File Type

@0 Uncompressed

Ew  Lossless Comp (L)
kaw, Lossless Comp (M)
Bawy  Lossless Comp (S)
RAW Compressed
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Shooting Menu - Image Quality

Video File Format

* The XAVC HS format uses the long GOP compression for

movies.

The XAVC HS format uses the HEVC codec, which has high
compression efficiency. The camera can record movies with
higher image quality than XAVC S movies but the same

data volume. Long GOP compression is used for movies.

The XAVC S-I format uses Intra compression for movies.
This format is more suitable for editing than Long GOP

compression.

For wildlife video 4K 60p or 120p is recommended for

smoother action playback.
120p will allow 4x slow motion and required S&Q mode.

For super slow motion (10x slo mo) record using HD 240p

which also required S&Q mode.

The A9 Il can be configured with separate Video and S&Q
settings but when using S&Q you will need to set recording
to either 4K 120p or HD 240p. Custom settings can be

used to switch between these modes quickly.

Shooting > Image Quality/Rec

1 In JPEG/HEIF Switch
Image Quality Settings

Aspect Ratio
'BFile Format XAVC S-1 4K
yBMovie Settings
a A5 % Shooting

v

WwPage E= [ENClose

A basic setting for movie shooting.
You can set all items when set to
movie mode.

OK

'BFile Format

" XAVC HS 4K
Y& XAVCS 4K
o> XAVC S HD
' XAVC S-14K
' XAVC S-1HD

@? @S




Shooting Menu - Image Quality

Video Movie Settings

e Set the default frame rate to 50p for video.

¢ \When the camera mode is set to video or S&Q mode

additional options are displayed - see sections that follow.

Shooting > Image Quality/Rec

1 In

JPEG/HEIF Switch
Image Quality Settings
Aspect Ratio

'BFile Format
»BMovie Settings

% AP 53 Shooting

v

WPage EI= [@Close

A basic setting for movie shooting.
You can set all items when set to

movie mode.

OK

Shooting > Image Qua... > *®Movie Settings

Rec Frame Rate

Rec Frame Rate

o 50p
® 25p

Shooting > Image Qua... > *®Movie Settings

Rec Frame Rate




Shooting Menu - Image Quality

High ISO Noise Reduction

e Turn off High ISO NR UNLESS you are not using RAW

image processing software to denoise your images.

* In general software such as DxO Photolab will produce

better denoise results than in-camera denoise processing.

Shooting > Image Quality/Rec
1 In High ISONR

Color Space
faLens Compensation

ENClose

High ISO NR

© Normal

® Low
e Off

Shooting > Image Quality/Rec
1 In HighISONR

Color Space
%aLens Compensation

WPage E=

Shooting > Image Quality/Rec
1 In HighISO NR

Color Space
faLens Compensation

WPage E=

Shooting > Image Qua... > Salens Compensation
Shading Comp.
Chromatic Aberration Comp.
Distortion Comp.

ENClose

ENClose




Shooting Menu - Media

Media Format

e Use this to format memory cards

Shooting 6/64

1 Image Quality/Rec Format
Media %aRec. Media Settings
File % Recover Image DB
Shooting Mode % Display Media Info.
Drive Mode
Composite RAW Sht.
Shutter/Silent

v

ENClose

Shooting > Media
Format
2 M SaRec. Media Settings
faRecover Image DB
S SaDisplay Media Info.

WPage E= [EBClose

Format

Select media card.

Performs Quick Format.
All data will be deleted.
OK?

Enter

Cancel

E@Switch Full Format

Formatting memory card...




. . Shooting > Media
Shooting Menu - Media Format

2 NV SaRec. Media Settings

. . . aRecover Image DB
Recording Media Settings , SuDisplay Media Ifo

e Record Images to Slot

* Record Video to Slot1 - note that | use 320GB CFE Type A
cards so running out of recording space is generally not an wPage E= [@Close
issue

Shooting > Media > SaRec. Media Settings

B Recording Media
'BRecording Media
Auto Switch Media Card

e Set Auto Switch to On so if Slot1 becomes full the camera

will automatically start using Slot2

Image Quality Settings

1 RAW

Shooting > Media > SaRec. Media Settings
@ Recording Media
'BRecording Media
Auto Switch Media Card

Image Quality Settings
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. . Shooting
Shooting Menu - File 11 Image Quality/Rec
Media
. . | File
File/Folder Settings & m Shooting Mode

Drive Mode
Composite RAW Sht.
Shutter/Silent

v

¢ | customise the folder and file names to make it easier to

identify which camera the images originate from.

e Set the File Name prefix to DGB - where DG are my initials
and B indicates the A9 Ill.

Shooting > File
File/Folder Settings

DG1 - Sony Alpha 1 Select REC Folder
3 Fi Create New Folder

DG9 - Sony Alpha 9 t IPTC Information

File name prefixes | use are as follows:

DGB - Sony Alpha 9 IIi Copyright Info

7/64
File/Folder Settings
Select REC Folder

Create New Folder

IPTC Information
Copyright Info

SaWrite Serial Number

WPage [E@Close

% Write Serial Number

DG5S - Sony Alpha 7r V

WPage

E= [EClose

Shooting > File > File/Folder Settings

File Number
Forced File Number Reset
Set File Name

« Folder Name

DGB01234
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Shooting Menu - File

File/Folder Settings

* In addition to changing the image file name prefix |
customise the generated folder names suffix to make it
easy to copy RAW files from the camera to computer
without any risk of having the same folder names from two

different cameras.
Folder naming | use is as follows:
e A1_IF - Sony Alpha 1 images folder
e A93IF - Sony Alpha 9 Ill images folder

Check that Select REC Folder now shows your customised

folder name suffix

Shooting > File
File/Folder Settings
Select REC Folder
3 Fi Create New Folder
IPTC Information

Copyright Info
% Write Serial Number

WPage K= [ENClose

Create New Folder

Create a new folder.

Last 5 char. of folder name can be changed.

A93IF

OK

Cancel

Shooting > File
File/Folder Settings
Select REC Folder
3 Fi Create New Folder
IPTC Information

Copyright Info
% Write Serial Number

wPage E= [EClose

Select REC Folder
O 100A93IF

DGB04750

DGB04754
ES



. . Set Photographer
Shooting Menu - File orap

Set the photographer name.

duncangroenewald.com

Copyright Info

* |f you wish to have your name or other copyright
information recorded with the images set the photographer

name and copyright information.

Shooting > File > Copyright Info Shooting > File > Copyright Info
Write Copyright Info Write Copyright Info
Set Photographer Set Photographer
Set Copyright Set Copyright
« Disp. Copyright Info « Disp. Copyright Info

Shooting > File > Copyright Info Set Copyright
Write Copyright Info

Set Photographer Set the copyright holder name.

Set Copyright duncangroenewald.com
« Disp. Copyright Info

0] 4

Cancel




Shooting > File

ShOOting Menu - File W File/Folder Settings
/ Select REC Folder
. . | Create New Folder

Copyright Info
% Write Serial Number

e To record the cameras serial number in the image files

enabled this setting

WPage E= [EBClose

7

Oa Write Serial Number

: 0 On
A e Off

Shooting 7/51
v M Image Quality Cont. Shooting Speed
Bl 21 Media Self-timer Type
i 13 File Bracket Settings
« |4 Shooting Mode Interval Shoot Func.
5 Drive Mode Pixel Shift Multi Shoot.
6 Shutter/Silent

7' Image Stabilization

~

WPage | EBClose
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Shooting Menu - Shooting Mode

Shooting Mode Settings

e The A9 Il allows you to configure 3 custom shooting

settings for each shooting mode (stills, video, S&Q)

* These modes (1,2,3) are available via the top shooting

mode dial

To save settings to one of the custom settings modes do the

following:

 Set up the camera focus mode, shutter speed, aperture,

iso, etc. to the setting you want to save

* Use the Camera Set. Memory option and select the setting

number 1,2 or 3.

Shooting 8/64
1 Image Quality/Rec B Recall Camera Setting

Media IR Camera Set. Memory
File IR Memory/Recall Media
Shooting Mode Reg. Custom Shoot Set
Drive Mode
Composite RAW Sht.
Shutter/Silent

v

WwPage [E@Close

Shooting > Shooting Mode

@ Camera Set. Memory
@ Memory/Recall Media
4, 4 S| Reg.Custom Shoot Set

WPage EI= [@Close

IR Memory 1 (2] 3 M1 M2 M3 M4

Q) 1/5000 F- 53 [E3°
=, RAW 3:2]

AWB
) A-B: 0 G-M: 0 VAF

B +0Ad+0GC £0dh 0 @0 M4 B3 A1 Antiflicker
AUTO OFF

5t LA

OFF

v [ED e0K




Shooting

ShOOtlng Menu - Drive Mode 11 Image Quality/Rec Drive Mode
Media Drive Mode Limit
. File Cont. Shooting Speed
D rive M Od S © 14 Shooting Mode Cnt Sht Spd Bst Settings
* New to the A9 lll is the option to disable the drive mode Drive M(?de Pre-C.apture L
dial and use the menu to select the drive mode or via and Composﬂg RAWSHL B
_ , , Shutter/Silent Bracket Settings
assigned toggle button to avoid having to use the top left v
. WPage [ENClose
dial.
e Set the camera shooting mode dial to * Shooting > Drive Mode 9/64

Drive Mode Cont. Shooting
Drive Mode Limit

Cont. Shooting Speed

Cnt Sht Spd Bst Settings

Pre-Capture Settings

Bracket Settings

v

WPage EI= [@Close

¢ Set the drive mode to Continuous Shooting: H+ Drive Mode

Continuous Shooting Speed

e dd HI MID »

T ENCancel ® OK



Shooting Menu - Drive Mode

Drive Mode Limit

® Drive Mode will be assigned to a toggle button to avoid

needing to use the dial to switch between H+, H

e Limit the toggle to the single and continuous modes only.

Shooting
Image Quality/Rec Drive Mode
Media Drive Mode Limit
File Cont. Shooting Speed
Shooting Mode Cnt Sht Spd Bst Settings
Drive Mode Pre-Capture Settings
Composite RAW Sht.  Self-timer Type
Shutter/Silent Bracket Settings

" WPage [ENClose

Shooting > Drive Mode 9/64
Drive Mode Cont. Shooting
Drive Mode Limit
Cont. Shooting Speed
Cnt Sht Spd Bst Settings
Pre-Capture Settings

Bracket Settings

v

WPage K= [ENClose

Drive Mode

HI
i°? EmCancel

Shooting > Drive Mode
Drive Mode
Drive Mode Limit
Cont. Shooting Speed
Cnt Sht Spd Bst Settings
Pre-Capture Settings

Bracket Settings

WPage E=

Drive Mode Limit

Continuous Shooting: Mid
Continuous Shooting: Lo
Self-timer(Single)
Self-timer(Cont)

Cont. Bracket

(0] ¢ Cancel

MID »

® OK

ENClose




Shooting Menu - Drive Mode

Continuous Shooting Speed

* To have access to all the shooting speeds we set the

default H+ shooting speed to 60 fps andaccess 120 fps via

a toggle button with Speed Boost speed to 120fps.

Shooting > Drive Mode

Drive Mode

Drive Mode Limit

Cont. Shooting Speed
Cnt Sht Spd Bst Settings
Pre-Capture Settings

Bracket Settings

v

WPage EI= [@Close

Shooting > Drive Mode > Cont. Shooting Speed 171

4

Oy Hi+ 60 images/s
Hi

2 Mid

GiLo

Drive Mode

HI

MID »

|7 ENCancel ® 0K

Shooting > Drive Mode
Drive Mode
Drive Mode Limit
Cont. Shooting Speed
Cnt Sht Spd Bst Settings
© 15 D Pre-Capture Settings

Bracket Settings

WPage E=

Cnt Sht Spd Bst Settings

0 120 images/s
® 60 images/s
® 30 images/s
® 20 images/s
® 15 images/s
® 10 images/s

120 images/s

ENClose




Shooting Menu - Drive Mode

Pre-Capture Settings

* Set the pre-capture recording time to 0.3 seconds. The
average human reaction time is 0.25 seconds so 0.3
seconds will usually be enough to ensure you capture

images from the start of the action.
e Set the pre-capture start trigger to Shutter Half Press

e Bear in mind that the buffer will accomodate about 1.6
seconds of compressed RAW files when shooting at 120fps
and the longer the pre-capture time the less time is
available for capturing action after the shutter button is

pressed.

* Reduce the capture frame rate for capturing extended

periods of action if necessary

Frame Rate Number of Seconds

120 1.6s
60 4s
30 14s
15 30+s

Shooting > Drive Mode
Drive Mode

Drive Mode Limit

Cont. Shooting Speed
Cnt Sht Spd Bst Settings
Pre-Capture Settings

Bracket Settings

WwPage E= [ENClose

Shooting > Drive Mode > Pre-Capture Settings
Pre-Capture
Pre-Capture Rec Time
Pre-Captr. Start Trigger

Cnt Sht Spd Bst Settings

0 120 images/s
® 60 images/s
® 30 images/s

® 20 images/s
® 15 images/s
® 10 images/s




Shooting 12/64

ShOOting Menu - |mage Qual |ty 3¢ 1 Image Quality/Rec % Silent Mode Settings

Media Release Lag/Start Disp.

. . File SaRelease w/o Lens
Sh utte r/SI |ent Settl ngs © '@ Shooting Mode Release w/o Card
“ 15 Drive Mode Anti-flicker Set.

Composite RAW Sht.
Shutter/Silent

v

e The A9 Ill has no mechanical shutter so these settings can

be ignored. Leave them as default values.

WPage [ENClose

Shooting > Shutter/Silent
faSilent Mode Settings
Release Lag/Start Disp.
aRelease w/o Lens
Release w/o Card
) Anti-flicker Set.

WwPage E= [EClose

Shooting > Shutter/Si... > %aSilent Mode Settings 171
Silent Mode off
Target Function Settings ]

If Auto Pixel Mapping is Off in Target
Function Settings, Pixel Mapping must be
performed manually on a regular basis.

@? @S




Shooting Menu - Image Quality

Shooting
8 Image Stabilization
9 Zoom

@ 4 Shooting Display

13/64
@ SteadyShot
% SteadyShot Adjust.

% (§) Focal Length

Image Stabilisation Settings

11 Marker Display

AFy

e SteadyShot on il Shooting Option

* | eave other settings as default.

WPage [ENClose

Shooting > Image Stabilization

8 |n @ SteadyShot

%a () Focal Length

WPage E= [ENClose

Shooting 11/51
- 18 Zoom %1Grid Line Display

G, 9 Shooting Display 11Grid Line Type

A Live View Display Set.

WPage | EClose




Exposure/Color Menu Customisations

Exposure/
Color

Exposure/Color

v I Exposure

Key Settings

Metering Mode: Spot, Focus Link

Zebra Display: On Exposure/Color

Zebra Level: Custom 100+ or Custom Std+Range 56+-3 Exposure

Exposure Comp.

Metering

- 4 Flash
White Balance
Color/Tone

Zebra Display

12/51
%1S0
%11S0 Range Limit
1SO AUTO Min. SS

EBClose

12/51
%lS0
%11S0 Range Limit
1SO AUTO Min. SS

WPage | [EClose



Exposure/Color 14/51
Exposure/Color Menu - Metering [ EMetering Mode
Exposure Comp. %sFace Priority in Mu...

. Metering %1Spot Metering Point
Metering Mode s W Fiash AELw/ St
White Balance
Color/Tone

* Spot Metering - adjust the ISO using spot metering

measurement. For birds and animals ideally we want the

focus point to be correctly exposed and not have the Zebra Display

exposure affected by the background that may be darker or WwpPage | EClose

lighter than th ject. ' ' :
ighter than the subject. See Spot Metering Point below Exposure/Color> Metering

F3Metering Mode

N

@ 31 M TiSpot Metering Point

e AEL w/ Shutter

WPage E@? [EClose

Metering Mode

a3 ENCancel ® OK




Exposure/Color > Metering

Exposure/Color Menu - Metering Metering Mode

3 V $aSpot Metering Point

Spot Metering Point AEL w/ Shute

* Focus Point Link - use the focus point as the point for spot
metering. Here we link the spot metering point to the

focus point. See Metering Mode above.
EDClose

Ya Spot Metering Point

O Center
® Focus Point Link

Exposure/Color > Metering
Metering Mode

3 V SaSpot Metering Point Focus Point Link
AEL w/ Shutter

WPage K= [ENClose
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Exposure/Color > Color/Tone

Exposure/CoIor Menu - Other %aD-Range Optimizer
%u Creative Look
Picture Profile

Color/Tone

e D-Range Optimiser - set this to Auto

e Creative Look - set this to VV2
WwPage E= [EClose

Ta D-Range Optimizer

Lv1 lv2 »
i3 ENCancel ® 0K

Exposure/Color 24/64 Exposure/Color > Color/Tone
W Exposure % D-Range Optimizer %aD-Range Optimizer
20 Exposure Comp. % Creative Look % Creative Look
31 Metering Picture Profile Picture Profile
4 Flash % Soft Skin Effect
5
6
7

e

White Balance
Color/Tone

Zebra Display
WPage [EBClose EB= [EClose




. Exposure/Color > Zebra Display
EXpOSUI‘Q/COlor Menu - Zebra DlSplay QaZebra Display

QuZebra Level

Zebra Display

 Turn this on to get zebra striped in the view finder for over

exposed areas of the image.
® Set Custom 1 as Lower Limit 100+ wPage E= [@Close
e Set Custom 2 as Std+Range 56 = 3

CaZebra Level

e Now select Custom 1 to set Zebra Level

Lower Limit 100+

| T ENCancel ® OK

Exposure/Color 25/64 o Zebra Level
1 Exposure aZebra Display

2! Exposure Comp. SaZebra Level
31 Metering

4 Flash
5
6
7

e

White Balance

Color/Tone
Std+Range 56 +3

B Mg

Zebra Display
WPage [E@Close i@? [EMCancel OO0K
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Focus Menu Customisations

Focus

26/64
. AF/MF Priority Set in AF-S
Key Setti Nngs Focus Area Priority Set in AF-C
| Subject Recognition ~ AF Lvl for Crossing
Focus Assistant AF Trk for Spd Chng
5 Peaking Display AF llluminator
Aperture Drive in AF

"y,
[>]

Preset Focus/Zoom

Priority Set in AF-C: AF WPage [EDClose

Focus Area Limit: Wide, Zone, Spot (small), Tracking Focus > AF/MF 26/64

Expandable Point 1 A Priority Setin AF-S
Priority Set in AF-C Balanced Emphasis
AF Lvl for Crossing
AF Trk for Spd Chng
AF llluminator
Aperture Drive in AF
Preset Focus/Zoom

v

WPage E= [EBClose
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Focus Menu - Auto/Manual Focus

AF/MF Settings

Priority Set in AF-C - select AF to ensure the camera will only

fire the shutter if it is in focus.

Use this to avoid large numbers of out of focus images if
shooting at high FPS e.g. Birds in flight. Some prefer to set
this to Release so the camera will fire the shutter regardless of
whether it is in focus or now claiming that they get more

usable shots.
Note that if Pre-Capture is on then AF mode is not available.

AF w/Shutter - turn this off to prevent shutter button
focussing. We will configure Back Focus Buttons for

focussing.

Priority Set in AF-C

® Release
O Balanced Emphasis

Focus> AF/MF
1 A AFw/ Shutter
Full Time DMF

WwPage EB= [EClose




28/64
Focus Menu - Focus Area v AF/MF & Focus Area
2 Focus Area faFocus Area Limit
3 Subject Recognition ~ Switch V/H AF Area
4 Focus Assistant SaFocus Area Color

Focus Area Settings

Ar'% | |
® Focus Area Limit - to limit the number of focus area S Peaking Display ARi\rea hegistration
Del. Regist. AF Area

AF Area Auto Clear

options that will appear in the Quick Menu (fn button) or &

programmed custom button. Disable modes that are

seldom used. WwPage [EClose

 Select Wide, Zone, Spot:XS, Tracking Expand Spot Focus > Focus Area
SuFocus Area

2 Fc %aFocus Area Limit
Switch V/H AF Area
faFocus Area Color
AF Area Registration
Del. Regist. AF Area
AF Area Auto Clear

v

WPage EI= ([EIClose

OaFocus Area Limit
Wide
23 (X [3] [&) [&]
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Focus > Focus Area

FOCUS Menu - FOCUS Area S Focus Area
2 Fc %wFocus Area Limit
. . Switch V/H AF Area
AF Area Reg IStration @ QaFocus Area Color
The Sony A9 Il allows you to configure to focus buttons and ARG .Reglstratlon
, , Del. Regist. AF Area
associate focus area modes to each of these buttons by using
_ o AF Area Auto Clear
the Registered Focus Area mode. _

WPage = [EBClose

To do this we need to first register a focus area mode by

doing the following: ' '
oing the tollowing AF Area Registration

e Enable AF Area Registration 0 On
e Off

You can register a focus area by long

pressing the Fn button in the shooting

screen. The registered focus area can
be recalled with the custom key.

OK




Focus Menu - Focus Area

OaFocus Area
Spot: XS

Get out of Menu mode

Use the Fn button to select the Spot: XS or Tracking

Expand Spot mode.
P P R—

* Now press and hold the Fn button until a message pops up

indicating that the mode has been registered. &°? EDCancel

Now use the Fn button to select Wide mode again.

In the next steps we will program the AEL button as a second
back focus button using the Registered Focus Area mode. So
by simply pressing either AF-ON or AEL button you get the

different focus mode instantly.

Registered the focus area.

1/20 F40 [ -20 ISO 800

OaFocus Area

& Focus Area

s X B €
ad [QIAF = C.‘.

OFF ON v
#/%Change E? ED E@3? ([E@Cancel @0K




Focus Menu - Subject Recognition

Subject Recognition

Subject Recog in AF - set On

Recognition Target - this will be selected via the toggle

button

Recognition Trgt Select Set - select the subject types you
want to be able to toggle through with the custom button
assignment. Select Human, Animal, Bird, Insect and/or other

subjects you might use.

| avoid using Animal/Bird since that will likely have worse

performance than the Animal or Bird specific modes.

30/64
AF/MF aSubject Recog in AF
Focus Area %aRecognition Target
Subject Recognition SaRecog Trgt Select Set
9 4 Focus Assistant SaRight/Left Eye Select
Peaking Display @ Sbj Recog Frm Disp.

% Face Memory

% Regist. Face Priority

WwPage [ENClose

Focus > Subject Recognition

faSubject Recog in AF

faRecognition Target
3 S SaRecog Trgt Select Set

g _ '

@ Shj Recog Frm Disp.
. aFace Memo
& ' g
=

WwPage E= [ENClose

Focus > Subject Recognition
CaSubject Recog in AF
faRecognition Target

3 S %aRecog Trgt Select Set

g _ ,

@ Shj Recog Frm Disp.
= CaFace Memory
O )

WPage EI= [@Close

©aRecog Trgt Select Set

Human

M Animal/Bird
Animal
Bird

Insect

Cancel



Focus Menu - Subject Recognition

Subject Recognition

Sbj Recog Frm Disc - turn on to display the subject

recognitions form in the view finder.

Focus > Subject Recognition
faSubject Recog in AF
%aRecognition Target

%aRecog Trgt Select Set

@ Shj Recog Frm Disp.
aFace Memory

WwPage EI= [EClose
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31/64
Focus Menu - Focus Assistant AF/MF Auto Magnifier in MF

Focus Area Focus Magnifier

Focus Assistant 2

AfuE
©

)
3 Subject Recognition % Focus Magnif. Time
4

Focus Assistant @ nitial Focus Mag.

Auto Magnifier in MF - On to automatically digitally zoom 51 Peaking Display Al

the image to show the precise focus points when manually

focussing.
EDClose
Initial Focus Mag. - x2.9 times magnification. This will zoom

in 2.9x when using the AF/MF Hold button on the lens in Focus > Focus Assistant

conjunction with a slight turn to the focus ring. Auto Magpnifier in MF

Focus Magnifier
Other settings as shown. % Focus Magnif. Time
A nitial Focus Mag.

AF in Focus Mag.

ENClose

Focus > Focus Assistant

Auto Magnifier in MF

% Focus Magnif. Time
4 Fc @lnitial Focus Mag.
AF in Focus Mag.

A
AfuE
—

ENClose




32/64
Focus Area % Peaking Level
Subject Recognition S Peaking Color

Peaking Display Settings b Focus Assistant

Peaking Display - set this to on to show the areas in focus in Peaking Display

the EVF.

Peaking Level - set this to High. EClose

Peaking Color - set this to your preferred colour so it is ——

Focus > Peaking Display

faPeaking Display
CaPeaking Level

© %aPeaking Color

4

visible against the background.

”ﬁj
%SP

ENClose

Focus > Peaking Display
%3Peaking Display
F1Peaking Level
%1Peaking Color

E3? ENClose




Playback Menu Customisations

Playback

Key Settings

Playback Option: Display as Group, Focus Frame Display

Playback

Playback Target
Magnification
Selection/Memo

Delete
Edit

Viewing
Playback Option

Image Index

Display as Group
Display Rotation
[>IFocus Frame Display
P Aspect Marker Disp
Disp Specified Time Img

Image Jump Setting

WPage [ENClose
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Playback > Playback Option

Playback Menu - Playback Image Index
Display as Group
) Display Rotation
PlaybaCk Optlon []Focus Frame Display
" I Aspect Marker Disp.

Display as Group - turn this on so that all shots in a sequence . B
Disp Specified Time Img.

as shown as a Group. With high shutter speeds this helps

7 Pl Image Jump Setting

make browsing the images on the camera much easier.
WPage EB? [ENClose

Focus Frame Display - turn this on so that the focus frame

gets shown during playback to allow you to confirm the point Playback > Playback Option
of focus. Image Index

Display as Group
Display Rotation
[>]Focus Frame Display
i Aspect Marker Disp.
Disp Specified Time Img.

7 Pl Image Jump Setting
wPage E? EClose




Network Menu Customisations

Network

Key Settings

Install Creative Cloud Mobile App




Setup Menu Customisations

Setup

. Area/Date @ Custom Key/Dial Set.
Key S ettin g S Reset/Save Settings  »®Custom Key/Dial Set.
Operation Customize  [*]Custom Key Setting
Dial Customize % Fn Menu Settings
Touch Operation [>]Fn Menu Settings
T Accessibility Different Set for Still/Mv
Finder/Monitor DISP (Screen Disp) Set
Custom Key/Dial Assignments - program the cameras buttons v

WPage [E@Close

and dials for specific functions.
Setup 39/51

1 Area/Date {Language
L M Reset/Save Settings  Area/Date/Time Setting
4 B Operation Customize ~ NTSC/PAL Selector
. @ Dial Customize
81 Touch Operation
B Finder/Monitor

B Display Option

WPage | [EClose



Setup > Operation Customize

@ Custom Key/Dial Set.
'BCustom Key/Dial Set.

Setup Menu - Operation Customise

. . . [>]Custom Key Setting
Stills Custom Key/Dial Settings e
Assign functions to the cameras buttons as shown on the [>]Fn Menu Settings

screens on the right. Different Set for Still/Mv
DISP (Screen Disp) Set

Thee buttons and dials allow you to quickly switch models _
WwPage E= [EClose

without needing to lift your eyes from the view finder.

B Custom Key/Dial Set.
Rear1

1 - Registered AF Area + AF On %] @ Reg. AF Area+AF On
—0 AF On

2 - AF On n @
o ® Pre-Capture

3 - Pre-capture \ / @ Display My Menu

(® Switch Drive Mode

4 - Display My Menu

Rear2

1 - Switch Drive Mode @ Custom Key/Dial Set.

Rear2

%] @ Switch Drive Mode
@ Not set
3 Not set

@) Not set
® Not set




B Custom Key/Dial Set.

5] @ Recog. Target Select
) (@ Zebra Display Select

Setup Menu - Operation Customise

Top
1 - Recog. Target Select
2 - Zebra Display Select

Front

1 - Continuous Shooting Speed Boost Toggle
B Custom Key/Dial Set.

1 - Tv (shutter speed) i] (@ Cnt Sht Spd Bst Toggle

Dial/Wheel

2 - ISO sensitivity

3 - Av (aperture)

B Custom Key/Dial Set.

B Separate M mode and other modes.
ja p

Tv

ISO




Setup > Operation Customize

Setup Menu - Operation Customise & Custom Key/Dial Set

'8 Custom Key/Dial Set.
[>]Custom Key Setting

Playback Custom Key Setting % Fn Mon Sefings

Set playback buttons as shown. [>]Fn Menu Settings
Different Set for Still/Mv

DISP (Screen Disp) Set
WPage N = [ENClose

[>]Custom Key Setting

Different Set for Stills/Movies

%) (@ Image Index
These settings allow you to make certain settings specific to @ &Enlarge Image

Stills and Movie mode. This means that changing a setting @ Follow Custom (@/'m)
while in Stills mode will not result in a change to the same @ Rating

setting in Movie mode. ® []Function Menu

® Delete
Generally you will need to have different Stills and Movie

settings.

Setup > Operation Customize
@ Custom Key/Dial Set.

'BCustom Key/Dial Set.
and switch to Movie mode and change to Spot then when ]Custom Key Setting

Currently it is not possible to make the Focus Area modes

independent. So is you are using Wide area mode in stills

you switch back to Movie mode the focus area mode will also o 6aFn Menu Settings

be Spot. © [>]Fn Menu Settings
Different Set for Still/Mv
DISP (Screen Disp) Set

WPage E= [EBClose




Setup Menu - Operation Customise
You can set different settings for still

iImage mode and movie mode in the next
Select all the settings making them independently adjustable screen.

in Stills and Move mode. The setting set for [/ is independent.

OK

Different Set for Still/Mv

Aperture
Shutter Speed
ISO

Exposure Comp.

Metering Mode
OK Cancel

Different Set for Still/Mv
ISO
Exposure Comp.
Metering Mode
White Balance
Picture Profile

OK Cancel




Setup > Operation Customize

REC w/Shutter

Set the movie record button to be the Shutter Button

ENClose




Setup Menu - Finder/Monitor

Display Quality

Set the display quality to High for highest resolution when

viewing images.

Finder Frame Rate

Set the finder frame rate to highest for 240 refresh rate and
smoothest viewing when following fast action or when

panning.

Note that when set to Highest the Display Quality will be set

Area/Date
Reset/Save Settings

Operation Customize

Dial Customize
Touch Operation
T Accessibility
Finder/Monitor

v

Setup > Finder/Monitor

56/64
Select Finder/Monitor
Monitor Brightness
Viewfinder Bright.
Finder Color Temp.
Viewfinder Magnifi.
@ Display Quality
@ Finder Frame Rate

WPage [ENClose

56/64

¢ 1 A Select Finder/Monitor Auto: 1

> Re Monitor Brightness
3 0 Viewfinder Bright.
4 D/ Finder Color Temp.

5 Tc |Viewfinder Magnifi.

6 X dDispIayQuaIity

Manual
Auto

+0

Zoom Qut

M Fii @Finder Frame Rate Higher

to Smp and the EVF viewing area will become smaller. -
WPage = [@Close

END OF CONFIGURATION GUIDE



A9 llIl Camera Configuration - Sample Images




A9 llIl Camera Configuration - Sample Images




A9 llIl Camera Configuration - Sample Images




A9 llIl Camera Configuration - Sample Images




A9 llIl Camera Configuration - Sample Images




A9 lll Camera Configuration - Video Links

is your's like glue

" ‘-‘-‘ \V [ ]
or like it is

duncangroenewald.com

Sony Alpha 9 IlI _
" IS THIS THE BEST FUN
for wildlife for wildlif EVERR?

-

Focus and Tracking % i


https://www.youtube.com/watch?v=N0Z-3kBV9J4
https://www.youtube.com/watch?v=vGTDHked2mE
https://www.youtube.com/watch?v=A-4Cn6hppGs
https://www.youtube.com/watch?v=0MjX6B_bH58

A9 llIl Camera Configuration - Video Links

Sony Alpha 9 lII Sony Alpha @il N

L 11

duncangroenewald.con

duncangroenewald.com

First THE.ONE nog&_ {h‘g THE BEAST

-

-



https://www.youtube.com/watch?v=PboFDmrxdYw
https://www.youtube.com/watch?v=moQ6oHhpcrg
https://www.youtube.com/watch?v=cxarHu-AUpM
https://www.youtube.com/watch?v=N3RqxUkS14I

duncangroenewald.com

Tips for
Managing
Files

The Sony Alpha 9 lll automatically numbers captured
files from 0001 to 9999 and then it creates a new

folder and starts numbering from 0001 again.

As a result it is quite possible to end up with files
with the same name on your computer and there is
some risk that you inadvertently overwrite a different
file if you copy a file to a folder containing a different

image that has the same file name.

To avoid any chance of this | rename imported files

to ensure the filename is always unique.



http://duncangroenewald.com

duncangroenewald.com

File Management Procedure

This is the procedure | use to avoid problems with duplicate

file names.
Camera File Naming

| have set my camera’s up to use different files names, as

follows:

Sony Alpha 1: DG1

Sony Alpha 9: DG9

Sony Alpha ¢ 1ll: DGB

Sony A6400: DG6

It seems the 4th digit in the Sony files names is unused and
is always ‘0"

So off the camera my file names appear like this:

DG100001.ARW
DG109999.ARW
DGBO0001T.ARW
DGB09999.ARW



http://duncangroenewald.com

In addition the camera creates new folders when the file sequence number reaches
'9999". Earlier firmware versions allow a maximum of 4000 files per folder so a new folder

is created after 4000 files.

Name

Computer folder management B 2018

B 2019
On my computer | store images in folders by year/month/day as shown on the right to B 2020

keep the folder structure manageable.Within each days folder there may be one or more W 2021

B 2022
v il 2022-01
2022-01-01
| 2022-01-02
2022-01-03
2022-01-16
2022-01-21
2022-01-23
2022-01-26
2022-01-28
2022-01-29
> @ 2022-01-30
v Il 2022-02
v [ 2022-02-01
> i 100ALPH1
v @ 2022-02-06
> [ 100ALPH1
> @ 101ALPH1

subfolders which are the folders copies directly from the camera memory cards.

Depending on the camera folder naming it may be necessary to rename these folders to
avoid conflicts. Newer firmware allows the camera folder names to be customised - see

the settings above.

Typically | try and make sure the folders are numbered in the order in which the images

were taken. With two cameras sometimes this would not make sense in which case | will

>
>
>
>
>
>
>
>

try and make sure the folder indicates which camera the folder comes from.
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Renaming image files to avoid duplicate

To avoid duplicate files names | rename the files once they have been copied to the computer. Fortunately on macOS it is quick

and easy to rename the files by performing the following steps:

1. Select all the files in the folder once they have been copied to the computer
2. Right click on the selected files and select the “rename” popup menu option
3. Select the “Replace Text” option

4. Enter the first 4 characters of the file names in the

Find: field as shown on the right (A1 example)

Replace Text ¢

5. Enter the first 3 characters of the file names, the date Find: DG10 Replace with: | DG1_20220101_1_

in YYYYMMDD format, and the folder sequence

number in the Replace with: files as shown below.

Example: DSC06457.ARW Cancel Rename

The files will now be renamed from DGB09999.ARW to DGB_20220101_1_9999.ARW thereby ensuring that even if two files
numbered 9999 taken on the same day by the camera end up being copied to the same folder they will not have the same file

name.

For example when shooing 16,000 swallow in flight images 6,000 files ended up with the same file name so | could never copy

all swallow files to the same location without the risk of overriding some other files.


http://duncangroenewald.com
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Sony Alpha 9 111 600 /4 TC1.4 @840mm 1/2000s 5.6  iso2500  handheld

Step 1: Make sure your ‘equipment’ is working - and |

don’t mean the camera or lens, we'll get to them later

Step 2: Determine how sharp your camera and lens
combination can be - this will set the ‘benchmark’ for what

you should be able to achieve

Step 3: Analyse your images - to determine whether there

is room for improvement in technique or whether you are

being limited by your equipment

Step 4: Determine why your images are not as sharp as

they could be - now you can work on improving things




Nikon D850 500PF @500mm  1/2500s

Step 1: Establishing how good your technique is

Before we worry about equipment let’s first establish how

well we can take images of fine detail from a long way away.

We do this by finding a static subject on a clear day,

preferably in the morning before the sun gets too high in the

A S AT
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-—-_--II-_-—--'I_-_II- "' ==
[l 1 1) ] 1] ] i

iso1000 is:panning  handheld from 3+km

sky. The perfect subject to use are buildings where there is

some construction work underway.

Use camera settings similar to those in the image on the
previous page and whatever the maximum reach of your
longest lens is (without any adapters on for now) and capture

a number of images as quickly as you can in single shot.



Nikon D850 500PF @700mm  1/100s 8 iso64 is:;panning handheld from ~100m

How steady are you What this shows is the amount of camera movement

occurring between each image which gives some idea of the

So while the single image on the previous Page is very sharp

, , , , amount of movement the camera image stabilisation system
and shows no signs of blurring the image on this page shows

o needs to deal with. Now do the same exercise in continuous
a number of consecutive images merged on top of each

" shooting mode and establish just how much lens movement
other.

is going on. Test it out with image stabilisation on and off.




Nikon D850 500PF @700mm  1/100s 18 iso64 is:none handheld from ~100m

Image Stabilisation Panning(or sports mode) which stabilises vertical movement

only since the camera expects you to be tracking horizontally

This image shows the amount of movement with no image . . .
and so no point trying to counter that motion.

stabilisation turned on

Regardless of whether you have image stabilisation on or off

As you can see there is quite a bit more vertical movement, . .
you will encounter some movement of the image unless you

bearing in mind that the previous images were taken using _ . o .
are using a tripod and even then it is worth checking.




1 2

Taking a closer look at the individual images taken without
image stabilisation we can see that we still managed to get

one sharpish(!) image.

So we know that our equipment is at least capable of doing

better than what is showing in the other 4 images.

Bear in mind that these images were taken with a slow
shutter speed of 1/100s and at a focal length of 700mm so
without the help of image stabilisation or a stable tripod it

will be near impossible to get sharp images.

At a minimum you should be getting A.



Let's take a closer look at the images to see what we can

find.

1. Clearly the main image is tack sharp with the cables,

crane structure and building lines showing as fine detail.

2. Zooming right in to 100% shows the same
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. And zooming in even further until we see some pixelation

we can see there is no evidence of any vertical or

horizontal blurring or double lines.

In this image we can see the same subject from two other

cameras were there is noticeably less sharpness but still

no evidence of any horizontal or vertical blurring.




So what does it mean if there is vertical or horizontal blurring . In this image there is no sign if any such artefacts

evident in the images ? "
J . And in this image the lines are even sharper. In addition

1. Here we can see the vertical lines appear to have double the definition in the light is starting to become more

images while the horizontal lines, while not sharp don't evident

show double artefacts . .
. And a processed image from a ultra-sharp prime lens




Sony Alpha 9 200-600 @600mm  1/2000s 6.3  iso5000 is:standard  handheld at 6m

FAQ: Take a look at the videos on the following pages to see how

1) Wh t lossl d? many compositions you would miss shooting at slower FPS.
y not lossless compressed?

. . | would rather the best wing positions/compositions than a
| do explain that lossless compressed means you can't get

barely noticeable improvement in dynamic range.
30fps - so if you don't need 30fps definitely use lossless Y P y J

compressed.




Sony Alpha 1 BIF Test

$
L
e
i

£
T+

A sequence of 44 images with many great shots of the
outstretched wings to choose from from 1.5 seconds of

‘action’.

If you are shooting at 5 frames per second you would be

lucky to get any of the wings in a good position.

e

i 3 A
Pl e Mty >

At 20 fps there is 30% less chance of getting that perfect

pose where everything lines up.

This was a test in the back yard so the background is not

ideal for keepers.



https://www.youtube.com/watch?v=6ViSm0nAj2s

Sony Alpha 1

200-600+TC1.4
SD Card(300MB)

YL

BIF Test with New Holland Honeyeater

Another much longer sequence of a New Holland Out of the hundred odd images there are a number of great
Honeyeater catching bugs. images where the bug and the bird is in focus and in a good

tion.
Who would have know they stack them up in their beak like pOSIton

a guinea-pig filling its cheeks. Reducing the shutter speed substantially reduces the chance

of getting a great image with the fast little birds.



https://www.youtube.com/watch?v=NAhTb-77Jzg

And finally a sequence of shots of a tern catching a fish,
dropping it and diving to retrieve it again, then nearly
loosing it as it breaks apart - not for fish lovers - and finally

flying in to feed its chick.

Once again without the high frame rate many of the little
subtle movements would not be picked up. If you watch
carefully you can see how the parent hand the fish to the
chick and then does a quick little movement to rotate the

fish so it is pointing head first into the chicks mouth.


https://www.youtube.com/watch?v=OAd57baNIk4

Sony Alpha 1 200-600 TC1.4 @840mm  1/40s

2) Why not set minimum shutter speed along with auto
ISO?

| only shoot in manual and control the shutter speed. Mostly

just shooting aperture wide open for wildlife to get the most
light on the sensor with the best light is morning/evening so

it's a pinch at the best of times anyway.

f9

iso250 is:standard handheld at 120m

Shutter speed could change from 1/40 to 1/8000 at a

moments notice depending on what is happening out there.

See this one above taken in very low light at 1/40s at 120

meters. But if the sun breaks through a second later...




Sony Alpha 1 200-600 TC1.4 @840mm  1/1600s {9 is0o6400 is:standard  handheld at 120m

Or the bird decides to take flight.... Even with noise reduction the image is lacking any real

: detail.
Note the low shutter speed in an unsuccessful attempt to

get enough light on to the sensor to keep the iso level

down.




Sony Alpha 1 200-600 TC1.4 @840mm  1/3200s {9 is0o2500 is:panning handheld at 40m

In better light you can use a higher shutter speed and still

keep the iso levels in a usable range.

If you look under the wings you can see signs of noise and
lack of detail in the shadows but the rest of the image is

pretty decent.



Sony Alpha 1 200-600 TC1.4 @840mm  1/4000s {9 iso2000 is:standard  handheld at 20m

A blindingly sharp image at 1/4000s with perfect light.




Nikon D850 200-500@500mm  1/4000s 7.1 iso640 is:standard handheld at 30m

And the Nikon colour magic with a high shutter speed for a sharp image with great eye detail
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